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Introduction

The Patient Assessment Documentation Package (PADP) Version 1.0 is a Veterans Health Information Systems and Technology Architecture (VistA) software application that enables Registered Nurses (RNs) to document, in a standardized format, patient care during an inpatient stay. Although the content is standardized for use across the VA system, some parameters can be set to support the unique processes at individual medical centers. 
PADP interfaces directly with several VistA applications, including Computerized Patient Record System (CPRS), Clinical Reminders, Consult Tracking, Allergy/Adverse Reaction Tracking, Mental Health Assistant, Vitals, and Patient Care Encounter (PCE). 

PADP is a Delphi application, which supports RNs in documenting patient care during an inpatient stay. It includes the following templates:  
· Admission – RN Assessment allows RNs to document the status of the patient at admission.

· Admission – Nursing Data Collection allows Licensed Practical Nurses (LPNs) and other nursing staff, including the RN, to enter basic patient data, such as vitals and belongings at the time of admission.

· RN Reassessment allows RNs to document the condition of the patient on a regular basis and any time during the inpatient stay. 
· Interdisciplinary Plan of Care interfaces with admission and reassessment data, and allows additional information to be entered by the RN and other health care personnel (physicians, social workers, chaplain, etc.). All clinical staff can enter information into the Plan of Care. The Plan of Care can be printed and given to the patient when appropriate.

PADP consists of a KIDS build, NUPA 1.0, and four (4) Delphi GUI templates in three executables. 
1. The executable, Admassess.exe, contains the Admission - RN Assessment template and the Admission - Nursing Data Collection template.
2. The executable, Admassess_Shift.exe, contains the RN Reassessment template.

3. The executable, Admassess_Careplan.exe, contains the Interdisciplinary Plan of Care template.

Each template is associated with a note. 
· The Admission - RN Assessment template is associated with the note: RN Admission Assessment 

· The Admission - Nursing Data Collection template is associated with the note: Nursing Admission Data Collection
· The RN Reassessment template  is associated with the note: RN Reassessment
· The Interdisciplinary Plan of Care template is associated with the note: Interdisciplinary Plan of Care
PADP adds to VistA, a new namespace (NUPA), four (4) Progress Notes, five (5) printouts, fourteen (14) files, thirty-six (36) parameters, and new health factors. The 5 printouts are:

4. The Daily Plan® is a health summary designed to be given to the patient and family

5. Plan of Care is a plan designed to guide the nursing staff

6. Discharge Plan is for discharge planners

7. Belongings is a list of patient belongings

8. Safe Patient Handling is designed to guide the transfer of a patient
Using the Interdisciplinary Plan of Care
The Interdisciplinary Plan of Care contains the data collected during the assessment and reassessment - problems, interventions, and assessments of patient progress by any health care professional. All clinical staff can access and contribute to the Interdisciplinary Plan of Care.
The plan of care is initiated when the admission assessment is uploaded into CPRS and VistA. 
Once information is entered into the plan of care, the data can be uploaded into an unsigned Interdisciplinary Plan of Care note that must be signed in CPRS. 

Note: Sign the Interdisciplinary Plan of Care note immediately after it is uploaded!

The first interdisciplinary plan of care uploaded after 12 midnight becomes a progress note. Additional updates during the following 24-hour period are uploaded as addenda to the first care plan uploaded after 12 midnight. 
· You cannot add addenda to an Interdisciplinary Plan of Care note until the note is signed. 
· After Midnight, a new note is automatically generated when the next plan of care is uploaded. 
· If no updates are entered into the plan of care, the upload option is unavailable.
When initiated, the interdisciplinary care plan looks back 14 days. If there was a previous admission within those 14 days, the previously entered care plan is pulled forward into the new care plan.

Opening the Interdisciplinary Plan of Care
You access the Interdisciplinary Plan of Care through CPRS from the Tools menu.

9. Open CPRS.
10. Select a patient.

11. Click Tools.
12. Select Interdisciplinary Plan of Care.
Enter a patient window automatically opens to the CPRS patient.

Note: You may have to re-enter your CPRS access and verify codes, depending on local site setup.
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Access through CPRS
13. Type the patient name in the Enter a patient text box.
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Interdisciplinary Plan of Care, Enter a patient window

14. Click OK.

Gen Inf 1 displays.
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Interdisciplinary Plan of Care, General Information Gen Inf 1 tab window

Saving and Uploading Data
The initial plan of care is generated using data entered on the Care Plan (CP) pages while documenting in the Admission - RN Assessment template.  

Note: When you upload data from the Admission - RN Assessment and/or the RN Reassessment, that data is also sent to the Interdisciplinary Plan of Care.
Auto Save

Data is saved automatically. Frequency of auto save is set locally.
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Saving data: percentage saved indicator
(bottom right corner of the window)
Upload Data
To create a note you must upload the data to VistA and CPRS: 
15. Open the File menu on any tab and select Upload Data.
Warning pop-up displays.
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Warning pop-up: You may not MAKE AN ADDENDUM for this unsigned 
INTERDISCIPLINARY PLAN OF CARE (note #21728910)
16. Click OK.
Error found message displays.
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Error found: There is a Interdisciplinary plan of care note that must be signed 
before you can upload these changes.

17. Click OK.

18. If required fields are incomplete, an Error Listing displays indicating the tab and issues that require attention.
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Error Listing window
19. Double-click an item to go to the tab that requires attention.

20. When all the errors are completed, select Upload Data again.
Exit 
21. From any tab, click X in the top right corner of the window.
Warning message displays.
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Warning pop-up: Do you really wish to exit?
22. Click Yes.

or
23. From any tab, open the File menu and click Exit. 
Warning message displays.
24. Click Yes.
Working in the Template

25. To complete the template, move through the fields from left to right and then down.
26. Each field with an asterisk (*) must have an entry. 
27. A field without an asterisk is optional. 

Moving through the Template with a Mouse
28. Click a tab at the bottom of any of the Interdisciplinary Plan of Care windows.
The selected tab opens.
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Interdisciplinary Plan of Care tabs
29. Open the Tabs menu and select a tab from the list.
The selected tab opens.
[image: image11.png]Interd| nary Plan of Care - Z|
File | Tabs Help

¢ General Information 1 Ctrl+Alt+G
g General Information 2 Ctrl+AIt+I

Education Ctrl+AIt+E
. Problems Ctrl+AIt+P
Functional Ctrl+AIt+F

ot
Discharge Planning ~~ Ctrl+AIt+D

Iw
View Care Plan Ctrl+Alt+V




Interdisciplinary Plan of Care, Tabs menu
Moving through the Template without a Mouse

Ctrl-Alt Keys
You can move from tab to tab using Ctrl+Alt+<letter>. The list contains the keys to use for each of the tabs.

	Tab
	Keys

	General Information 1
	Ctrl +Alt+G

	General Information 2
	Ctrl +Alt+I

	Education
	Ctrl +Alt+E

	Problems
	Ctrl +Alt+P

	Functional
	Ctrl +Alt+F

	Discharge Planning
	Ctrl +Alt+D

	View Care Plan
	Ctrl +Alt+V


Go to radiogroup

The Go to radiogroup: is designed to navigate the templates with keyboard commands, when the mouse stops working during a patient assessment. It also satisfies the 508-compliant requirement, under Section 508 of the Rehabilitation Act, to be able to navigate the templates without using a mouse. 
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Go to radiogroup
30. Use the Tab key to move to the bottom of the page.

31. Use the arrow keys to move up/down in the Go to radiogroup: list.

32. Click OK.

or

33. Click the drop-down arrow in the Go to radiogroup: drop-down list.

34. Select a radiogroup.

35. Click OK.

Navigating the Interdisciplinary Plan of Care Tabs

The Interdisciplinary Plan of Care template has seven tabs.
General Information 1 (Gen Inf 1)
The Interdisciplinary Plan of Care template opens to the General Information 1 (Gen Inf 1) tab, the first tab at the bottom on the left. The Gen Inf 1 tab pulls information from the Admission – RN Assessment or a previous Interdisciplinary Plan of Care. 
The Gen Inf 1 tab contains:
· Background 
Pulled from the Admission – RN Assessment and other VistA files and cannot be edited

· Admitted 
Date and time patient is admitted

· Morse Fall Score 
Pulled from previously entered data and cannot be edited from the Plan of Care 

· Braden Score 
Pulled from previously entered data and cannot be edited from the Plan of Care

· Guardian 

· Preferred Healthcare Language

· Suspected victim of abuse/neglect

· Cultural Practices 

· Blood transfusion concerns

· Patient has an Advance Directive

· Special diet needs
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Interdisciplinary Plan of Care, General Information, Gen Inf 1 tab window
36. On the Gen Inf 1 tab, make changes if necessary.
37. Click Gen Inf 2.
Gen Inf 2 displays.

Example 
If a Patient has an Advance Directive, you can change No to Yes. Advance directive location becomes available and because it is required, you can document the current location of Advance Directive.
General Information 2 (Gen Inf 2)

The General Information 2 tab pulls information from the Admission – RN Assessment or a previous Interdisciplinary Plan of Care. The Gen Inf 2 tab is read-only.
The Gen Inf 2 tab contains:
· Allergies 

· Current Inpatient Meds (last 3 days) 

· Precautions/Flags 

· Current Active or Pending orders since yesterday
· Display only orders entered since yesterday (checked/unchecked)
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Interdisciplinary Plan of Care, General Information, Gen Inf 2 tab window
Review the information in the Gen Inf 2 tab; no changes can be made on Gen Inf 2.
Education (Educ)
The Education tab pulls in previously entered information. You can change the responses, if the patient’s condition requires education modifications.
The fields are like the Educational Assessment in the Admission - RN Assessment and the RN Reassessment. 
· Patient/family/support person oriented

· Able to assess education

· Learns best by 
· Prefers (method of learning)
· Readiness to learn
· Barriers to learning 
· Knowledge of current illness, surgery, reason for hospitalization etc. as identified by patient
· Information provided to patient on the following topics
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Interdisciplinary Plan of Care, Education, Educ tab window
In the Educ tab, make changes if necessary.
Problems/Interventions/Desired Outcomes (Prob)
Problems are listed in the table on the Problems/Interventions/Desired Outcomes (Prob) tab. 
You can view:

· All problems for the current hospitalization of the patient, including resolved problems, or 

· Only active problems
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Interdisciplinary Plan of Care, Problems/Interventions/Desired Outcomes, Prob tab window
Note: To switch between the two views, select or clear the Do not display resolved problems check box.
Care Plan Table
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Interdisciplinary Plan of Care, Problems/Interventions/Desired Outcomes table
The width of each Prob tab column is adjustable. There are ten columns in the Care Plan (Problems/Interventions/Desired Outcomes) table.
	Column Name
	Description

	Tab
	Tab in which the problem was identified in a previous assessment
Example
The problems came from the Mental Health Assessment, MH tab.

	Problem
	Problem of concern from a previous assessment

	Date Identified
	Date the problem was identified

	Desired Outcome
	Preferred resolution of the problem

	Prob Eval
(Problem Evaluation)
	In relation to the problem, how are things going?
a. No change/Stable 
b. Deteriorating 
c. Improving 
d. Resolved
e. Unresolved at discharge

	Prob Eval Date
(Problem Evaluation Date)
	Date on which the problem was last evaluated

	Intervention
	The what to do for the patient you identify, so that the problem will improve/get better/not get worse

	Int Started 
(Intervention Started)
	Date on which the intervention was initiated

	Int Status 
(Intervention Status)
	In relation to the intervention, how should the staff proceed?
f. Complete

g. Continue

h. Discontinue

i. Pending (intervention was ordered but not started, such as a special bed or a lab test)
j. Not on file (status not evaluated)

	Int Stat Date
(Intervention Status Date)
	Date on which the status of the intervention was evaluated


Updating an Existing Problem/Intervention
38. Click a problem.
Problem evaluation and Intervention status become available. 
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Interdisciplinary Plan of Care, Problems/Interventions/Desired Outcomes, Prob tab window
Problem evaluation and Intervention status available
39. Click the problem again to view its Problem/Intervention detail.
A summary of the problem displays with the specific intervention and statuses.
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Interdisciplinary Plan of Care, Problems/Interventions/Desired Outcomes, Prob tab window
Problem/Intervention detail available
40. Select a problem evaluation and an intervention status for a selected problem.
Evaluate both the problem and the specific interventions each time you document.
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Problem evaluation, Intervention status, and Problem/Intervention detail

41. To delete entered data before saving, click Cancel.
42. Click OK.
Information pop-up displays.
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Information pop-up: Plan/Intervention updated!
43. Click OK to complete the problem/intervention update.

44. To update additional problems/interventions, repeat steps 1-6, as necessary.

45. Review the care plan table.
The Prob Eval/Int Status are updated and the Prob Eval Date/Int Status Date are added.
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Interdisciplinary Plan of Care, Problems/Interventions/Desired Outcomes, Prob tab window 
with an updated problem
46. Click View history for this problem to view the history of the selected problem.
The Problem History displays.
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Problem History window
47. Click Close.

Adding a New Intervention for an Existing Problem

48. Click a problem.

49. Click Add New Intervention to this problem.
The Add New Problem/Intervention window displays with the area and problem selected.
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Add a New Problem/Intervention window
50. Select one or more interventions from the Select Interventions list box.

51. Click Add.
Information pop-up displays.
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Information pop-up: New Intervention added!

52. Click OK.
53. Click Exit.
Information pop-up displays.
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Information pop-up: IDPC note created - #(21728909)
Be sure to sign it in CPRS!
54. Click OK.
Problems/Interventions/Desired Outcomes window redisplays with the new intervention.
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Interdisciplinary Plan of Care, Problems/Interventions/Desired Outcomes, Prob tab window 
with a new intervention added
55. To add more interventions, repeat steps 1-7.

Adding a New Problem/Intervention
56. Click Add New Problem.
Add New Problem/Intervention window displays. 
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Add New Problem/Intervention window
57. Select an area from the Click a problem area list box. 
The Select Problem(s) list box displays.
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Add New Problem/Intervention window
Select Problem(s) available

58. Select a problem from the Select Problem(s) list box.
You can select only one problem at a time.
The Desired Outcome text box and the Select Interventions list box display.
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Add New Problem/Intervention window for problem/intervention options
59. Select an intervention from the Select Interventions list box.

60. Click Add.
Information pop-up displays.
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Information pop-up: New Problem/Intervention added!

61. Click OK.
62. Click Exit.
Information pop-up displays.
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Information pop-up: IDPC note created - #(21728908)
Be sure to sign it in CPRS!
63. Click OK.
Note: The Prob tab redisplays with the new problem and its related intervention(s) added to the table (grouped according to tab).
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List of Problems/Interventions/Desired Outcomes with new problem added
64. To add more problems/interventions, repeat steps 1-8, as necessary.
Other Problems
Some problems generate a pop-up to enter problems that are not on the predefined list.

65. Select an Other problem in the Select Problems list box.
The Other problems pop-up displays.
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Add New Problem/Intervention window with Other pop-up
66. Type the other problem into the text box.

67. Click OK.
Information pop-up displays.
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Information pop-up: Be sure to enter the desired outcome (free text).
68. Click OK.

69. Type a desired outcome into the Desired Outcome text box.
70. Select one or more interventions from the Select Interventions list box.
71. Click Add.
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Information pop-up: New Problem/Intervention added!
72. Click OK.
73. Click Exit.
74. To add more other problems, repeat steps 1-9, as necessary.
Other Interventions
Some interventions generate a pop-up to enter interventions that are not on the predefined list.

75. Select an Other intervention in the Select Interventions list box.
The Other intervention pop-up displays.

76. Type the other intervention into the text box. 
77. Click OK.
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Add New Problem/Intervention window with Other pop-up
78. Click Add to transfer the intervention to the plan of care.
Information pop-up displays.
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Information pop-up: New Intervention added!
79. Click OK.

80. Click Exit.
Information pop-up displays.
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Information pop-up: IDPC note created - #(21728911)
Be sure to sign it in CPRS!
81. Click OK.

82. To add more other interventions, repeat steps 1-7, as necessary.

Functional (Func)
The Functional Assessment tab contains the information that you need to transfer a patient safely, using mechanical lifting devices and approved aids for lifting, transferring, repositioning, and moving patients.
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Interdisciplinary Plan of Care, Functional Assessment (Func) tab window
83. Select one or more for each type of transfer, type of device, and number of staff needed.

84. Select a sling type and sling size, if necessary.
85. Click Print.
86. Print the information and give it to the staff handling the transfer.
Discharge Planning (DP)
The Discharge Planning tab contains issues pulled forward into the list of Current discharge planning issues, identified previously in the Admission – RN Assessment or older plans of care.
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Interdisciplinary Plan of Care, Discharge Planning (DP) tab window
87. Select one or more items in the Current discharge planning issues list box.
As you select an item, it moves to the comment text box on the right.

88. Review the discharge planning issues and modify, as appropriate, based on the current situation.
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Interdisciplinary Plan of Care, Discharge Planning (DP) tab window
Involve family/support person in discharge planning selected
89. To add comments for a selected discharge issue, double-click the discharge planning issue.
Discharge Planning Comments window displays.
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Discharge Planning Comments window
90. Add a comment for the selected issue.

91. Click OK.
Comments display in the Plan/interventions/observations/comments history along with the associated discharge planning issue and the name of the staff that entered the comment.
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Interdisciplinary Plan of Care, Discharge Planning (DP) tab window
View Care Plan (View CP)
The View Care Plan (View CP) tab allows you to view and print three different perspectives of the Plan of Care. 

92. The Daily Plan®
The Daily Plan® is a summary of current orders for nurses, or other clinicians, to review daily with the patient, as appropriate. The RN can print a copy of The Daily Plan® for the patient by selecting the Patient requests a copy of The Daily Plan® check box. The daily plan should be re-evaluated after each reassessment because patient status may change. 
93. Plan of Care
The Plan of Care contains general information and problems/interventions from the Interdisciplinary Plan of Care, Prob tab.
94. Discharge Plan
The Discharge Plan contains information about home environment, living arrangements, special equipment, and other needs.
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View Care Plan window: View/print documents menu

The Daily Plan®
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Interdisciplinary Plan of Care, Daily Plan
The Daily Plan® is a health summary that contains the following General Information components for the Latest Care Plan:
· Patient Name

· DOB (Date of Birth)
· Ward

· Entered (date/time)
· Special diet needs
· Next of kin
k. Contact

l. Relationship

m. Address

n. Phone

o. Work phone
· Allergies

· Current Inpatient Meds (last 3 days)
· Current Active or Pending orders since yesterday
p. Order type

q. Item ordered

r. Start date

s. Ordered by
Appointments in the next year

Plan of Care
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Interdisciplinary Plan of Care, Plan of Care
The Plan of Care includes General Information components for the Latest Care Plan:
· Patient

· DOB (Date of Birth)
· Ward

· Entered (date/time)
· Problems
t. Problem

u. Date identified 

v. Desired outcome
w. Prob eval (evaluation)
x. Prob eval (evaluation) date 

y. Intervention 

z. Int (intervention) started
aa. Int (intervention) status 

ab. Int (intervention) status date 
Discharge Plan
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Interdisciplinary Plan of Care, Discharge Plan
The Discharge Plan includes General Information components for the Latest Care Plan:
· Patient 

· DOB (Date of Birth)
· Ward
· Entered (date/time)
· Discharge Planning

ac. Current discharge planning issues
ad. Prior comments
Glossary
	Term
	Definition

	ADPAC
	Automated Data Processing Application Coordinator

	ART
	Adverse Reactions Tracking

	BCE
	Bar Code Expansion

	BCE-PPI
	Bar Code Expansion-Positive Patient Identification

	BCMA
	Bar Code Medication Administration

	Belong
	Belongings

	CAC
	Clinical Application Coordinator

	CIWA
	Clinical Institute Withdrawal Assessment.--CIWA

	Class 1 (C1)
	Software produced inside of the Office of Enterprise Development (PD) organization

	Class 3 (C3)
	Also known as Field Developed Software 
Refers to all VHA software produced outside of the Office of Enterprise Development (PD) organization

	CMS
	Centers for Medicaid and Medicare Services

	COTS
	Commercial Off the Shelf

	CP
	Care Plan

	CPRS
	Computerized Patient Record System

	CV
	Cardiovascular Assessment

	Delphi
	Programming language used to develop the CPRS chart

	DFN
	Data File Number

	DP
	Discharge Planning

	Educ
	Educational Assessment 

	Func
	Functional Assessment

	Gen Inf
	General Information tab

	GI
	Gastrointestinal Assessment

	GU
	Genitourinary Assessment

	GUI
	Graphical User Interface

	ICD
	International Classification of Diseases

	ICN
	The patient’s national identifier, Integration Control Number 

	IDPA
	Interdisciplinary Patient Assessment - involves multiple disciplines responsible for assessing the patient from their perspective and expertise.

	IDPC
	Interdisciplinary Plan of Care -  The entry of treatment plans by multiple disciplines to meet JCAHO requirements

	IV
	Intravenous

	IV Central
	Central IV lines

	IV Dialysis
	IV Dialysis ports

	IV Periph
	IV Peripheral lines

	JCAHO
	Joint Commission on Accreditation of Healthcare Organizations 

	LPN
	Licensed Practical Nurse

	M/S
	Musculoskeletal Assessment

	MAS
	Medical Administration Service

	MH
	Mental Health Assessment

	MRSA
	Methicillin-Resistant Staphylococcus Aureus

	NAA
	Nursing Admission Assessment 

	Neuro
	Neurological Assessment

	NHIA
	Nursing Healthcare Informatics Alliance

	NPAT
	National Patient Assessment Templates

	NUPA
	Namespace assigned to  the Patient Assessment Documentation Package (PADP) by Database Administrator

	OED
	Office of Enterprise Development

	OERR
	Order Entry Results Reporting

	OIT
	Office of Information and Technology

	ONS
	Office of Nursing Services

	Orient
	Orientation to Unit

	P/S
	Psychosocial Assessment

	PADP
	Patient Assessment Documentation Package 

	Pain 
	Pain Assessment

	PC
	Plan of Care

	PCE
	Patient Care Encounter

	PD
	Product Development

	PHR
	Patient Health Record

	Prob
	Problems/Interventions/Desired Outcomes tab in the RN Reassessment

	Resp
	Respiratory Assessment

	Rest (or Restr)
	Restraints

	RN
	Registered Nurse

	RPC
	Remote Procedure Call

	RSD
	Requirements Specification Document

	Section 508
	Under Section 508 of the Rehabilitation Act, as amended (29 U.S.C. 794d) Public Law 106-246 (http://va.gov/accessible) agencies must provide employees and members of the public who have disabilities access to electronic and information technology that is comparable to the access available to employees and members of the public who are not individuals with disabilities

	Skin
	Skin Assessment

	SNOMED – CT
	Systemized Nomenclature of Medicine Clinical Terms

	TIU
	Text Integration Utilities Program
All text in CPRS is stored in TIU

	TJC
	The Joint Commission

	V/S
	Vital Signs

	VA
	Department of Veterans Affairs

	VAMC
	Department of Veterans Affairs Medical Center

	VANOD
	VA Nursing Outcomes Database

	VHA
	Veterans Health Administration

	VistA
	Veterans Health Information Systems and Technology Architecture
An enterprise-wide information system built around an electronic health record used throughout the Department of Veterans Affairs medical system.

	Vital Qualifiers
	Provide detail in to the unit of measurement used with the vital signs.  

Height in inches or centimeters?  

Weight in pounds or kilograms?


For additional PADP information, refer to the user manuals for Admission - RN Assessment, RN Reassessment, and Admission - Nursing Data Collection.
Documentation for NUPA Version 1.0 is also available on

· VA Software Documentation Library in the Clinical Section 
http://www4.va.gov/vdl/
· PADP SharePoint for NUPA Version 1.0 http://vaww.oed.portal.va.gov/programs/class3_to_class1/padp/field_development
38
Patient Assessment (NUPA) V.1
April 2012

Interdisciplinary Plan of Care User Manual
April 2012
Patient Assessment (NUPA) V.1
37

Interdisciplinary Plan of Care User Manual

